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	Symbol
	Unit
	Meaning

	
	
	

	A
	m2
	area

	C
	/
	concentration

	D
	m2 s-1
	diffusion coefficient

	d
	mm
	diameter

	P
	Pa, bar
	pressure

	V
	m2
	volume

	
	
	

	v
	m s-1
	speed

	γ
	m2 l-1
	growth rate of lubrication

	ε
	/
	efficiency

	η
	Pa s
	dynamic viscosity

	
	
	

	Indexes
	
	

	
	
	

	cel
	whole 
	

	f
	filtration
	

	k
	concentration  
	

	p
	permeate 
	

	z
	initial
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	Abbreviation
	Meaning

	
	

	ACH
	aluminium chloride, a type of coagulant

	CODMn
	the oxygen equivalent required to oxidise the organic content of the sample using trivalent manganese (Chemical Oxygen Demand)

	GAC
	granular activated carbon

	MF
	Microfiltration

	NF
	nanofiltration

	PAC
	Powder Activated Carbon

	RO
	reverse osmosis

	SCADA
	supervisory control and data acquisition system

	TOC
	the total amount of all organic compounds in the sample (Total Organic Carbon)

	TSS
	amount of all suspended solids in the sample (Total Suspended Solids)

	UF
	ultrafiltration
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[bookmark: _Ref411432271][bookmark: _Toc124842319]Introduction
[bookmark: _Toc124842320][bookmark: OLE_LINK5]Background of the problem
The introductory chapter should contain two subchapters: 1.1 Background to the problem and 1.2 Objectives of the thesis. Chapter 1.1 Background to the problem should contain at least one introductory paragraph giving a general description or explanation of the topic. Outline the background to the dissertation and its significance.


[bookmark: _Toc397007869][bookmark: _Toc124842321]Objectives
Problems, objectives, and structure (description of the content, division into chapters) of dissertation should be presented in a separate subchapter.

Do not present results and conclusions in the introduction. In this section, focus on what will be presented in the thesis and how the thesis is structured. Write about what you will be doing, what you expect to get out of theoretical and practical research, and what the risks and pitfalls are of not achieving these goals. Write about hypotheses, not results.


[bookmark: _Toc124842322]Instructions for using dissertation template
In this template, in the non-content part of dissertation (up to page xxvi), the part of the text that the student needs to change to match his/her information and the information about his/her dissertation is highlighted in red. The Table of Contents, Table of Figures, and Table of Tables only need to be refreshed at the end of the writing process (please follow the instructions in chapter 1.3.1 Using pre-set styles in a template. The full text of the thesis (including the non-content part - up to page xxvi) must be written in black at the end!

This template provides guidance and examples for the formatting of dissertation in the body of dissertation. Full text (main headings remain: Introduction, Theoretical background, and literature review, etc.) must be replaced by text that corresponds in content to the student's dissertation.


[bookmark: _Ref411954360][bookmark: _Toc124842323]Using pre-set styles in a template
Use this template to write your dissertation, which comes with pre-set styles to standardise the final format of FME dissertations. 

As can be seen in 'Home' -> ‘Styles, choose:
'Normal' for most of the text,
'Preface' for headings in the formal part of dissertation on p. v–xxv (e.g., Extract),
'Heading 1' for the main headings (e.g., 1 Introduction),
'Heading Literature/Appendices' for the Bibliography and appendices headings (e.g., Appendix A),
'Heading 2' for Level 2 heading (e.g., 2.6 Equations),
'Heading 3' for Level 3 heading (e.g., 2.6 Literature inventory samples),
'Heading 4' for Level 4 heading (e.g., 2.6 Level 3 subchapter),
'List Paragraph' for indentation – see 2.3.1.3 Listing levels (3 indentation levels are pre-set),
'Conclusions' to state the conclusions in Chapter 6 Conclusions,
'References' to list references in the reference list (if you use a citation software, adapt the look of the reference list to this style).

For figure and table titles (and equation numbering), use the auto-numbering option below the figure or above the table: 'References' -> 'Insert caption' And then in the ‘Label' field select 'Image' for the title of the Figure or ‘Table' for the title of the table. This way you can easily number figures and tables automatically (e.g., you do not need to manually correct the numbering if you insert a new figure or table in the text) and also easily create a list of figures and a list of tables: at the end of the dissertation, right-click on the List of Figures and List of Tables and select 'Refresh field' to automatically refresh the lists. Similarly, at the end, you can refresh the Table of Contents by right-clicking on the table of contents field and selecting 'Refresh field'.

To insert an equation such as (2.2) in chapter 2.5 Equations, it is recommended to first save the new equation style as follows. First, highlight the entire line of the equation in the template, e.g., (2.2), and in the 'Insert' tab select the 'Equation' option. Then select the option 'Save Selection to Equation Gallery…'). In the dialog that opens in the 'Name:' field enter the desired name (e.g., 'Equation with numbering'), in the ‘Gallery: Equations', select 'Category: General', and leave the other fields unchanged. Confirm the entry of the new equation style. You can now insert a new equation into the text by selecting the 'Equation' option in the 'Insert' tab and then select the 'Equation with numbering' option, which inserts a 2-column table with a sample equation and numbering added.


[bookmark: _Toc124842324]Reference to parts of the text
As Word does not allow you to hyphenate words when referring directly to an image or table, we recommend the following way of referring to figures or tables (or other parts of the text). When you insert a figure title (e.g., Figure 2.1: Example image...'), indicate the figure number (in this case 2.1) in the figure caption and select the 'Bookmark' option in the 'Insert' tab.   Then in the 'Bookmark name' field enter the name by which you will recognize this bookmark. Then, at the desired point in the text where you want to insert a reference to Figure 2.1, select the 'Cross-reference' option in the 'References' tab, then in the field ‘Bookmark type’ select the option 'Bookmark’, in the field 'Insert reference to' select 'Bookmark text' and then select the appropriate bookmark in the menu. This way, the references will be preserved even if, for example, you insert new figures, tables, etc. into the text.

Similarly, you can also refer to e.g., chapter headings (numbered parts of the text, equations or other text strands) using the 'References' -> 'Cross-reference' option, when in the field ‘Bookmark type’ select the 'Heading' option, select the desired option in the 'Insert reference to' field and then select the desired title to which you refer.
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Introduction
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[bookmark: _Toc397007870][bookmark: _Ref411424453][bookmark: _Toc124842325]Theoretical foundations and literature review
[bookmark: _Toc124842326]Content
[bookmark: OLE_LINK7]Whether the dissertation is theoretically or experimentally oriented, it is first necessary to work on the theoretical foundations of the subject. 


[bookmark: _Toc124842327]Source of information
When reviewing the literature, books and professional and scientific articles should be the main source of information. We recommend using the following search engines to find papers and other literature online: Dikul, Web of Science, ScienceDirect and Google Scholar.

Read more about citing sources later in this template.


[bookmark: _Toc124842328]Subchapters and styles
Divide the individual chapters into subchapters, which should be numbered consecutively. The format and style of the headings should correspond to those shown in this template. The numbering should be automatic, as shown in this template. You can use this template directly to write your dissertation, as all the styles are pre-set (plain style, style for chapters and subchapters, style for the Bibliography chapter heading, style for table and figure headings, etc.).

[bookmark: _Toc397007871][bookmark: _Toc411798033][bookmark: _Toc124842329][bookmark: _Toc397007872]Level 2 subchapter
[bookmark: _Toc124842330]Level 3 subchapter
The first lines of paragraphs should not be indented, but there should be one blank line between each paragraph. There should be 2 blank lines between the heading of the subchapter and the end of the preceding text. If the heading of a subchapter starts immediately after the heading of a higher-level subchapter, there should be no blank lines between the headings. You can use up to 4 levels of headings, i.e., the main heading and 3 levels of subheadings.


Additional text delimitation

If you want to further separate the individual parts of the text in the last, 4th level of the subchapter, you can use one line of bold print (Times New Roman, 12 pt), separated from the preceding text by 2 blank lines (or no line spacing if it follows directly the subchapter heading), and the text that follows should follow with 1 blank line spacing.


[bookmark: _Toc124842331]Use of bold print, italics and underlining
In addition to the previous example, the use of bold print makes sense:
when a concept very important for understanding the task is mentioned and defined for the first time in the text,
when you want to emphasise a particular part or thought,
when, for example, you want to visually separate parts of the text when enumerating.

When using words from foreign languages in the text, use italics. As a rule, we do not use underlining.


[bookmark: _Toc124842332]Enumeration levels
Regardless of how many hierarchical indent levels are used for enumeration in the text (usually no more than 2), we always use the same combination throughout the text and the same way of marking each indent level. This gives the text a uniform appearance.

Use the “-” mark to indicate indentation level 1, aligned left with the page margin or text margin, and the text of indentation level 1 should follow 0.5 cm from the left edge of the page. The indentation level 2 is indicated by the “-” mark, which should be 0.75 cm from the left margin of the page, and the text following it should be 1.25 cm from the left margin of the page. An example is shown below:
level 1 example:
level 2 example:
level 2 example:
level 1 example:
level 2 example:
level 2 example:

The new paragraph of text should be preceded by 1 blank line of space after the last indent, or 2 blank lines of space if the last indent is followed by the title of a new chapter.


[bookmark: _Toc124842333]Tables
Tables should be numbered consecutively. The numbering starts with a number of Level 1 of the chapter in which the Table is located, followed by the sequential number of the figure in that chapter. Table should be centred. An example is shown in Table 2.1.

[bookmark: OLE_LINK2][bookmark: OLE_LINK1]The table caption, with the table's serial number and a brief description, should appear above the table, aligned with the left margin of the text. The table caption number should be in Times New Roman, size 11 pt., as should the ‘:’ after the table number. The short description of the table should begin with a capital letter and end without final punctuation and should be in Times New Roman, size 11 pt. There should be 1 (blank) line of space between the text and the title of the table, as in the case of 2.1, unless the title of the table is completely at the top of the page. The table caption should be set to 12 pt. top and 12 pt. bottom indent. The heading/caption style is already pre-set in this template. There should be no spaces (blank lines) between the table and the table caption. There should be 2 blank lines between the table and the following text, as shown for the table 2.2.

[bookmark: _Toc120268081][bookmark: Ucinkovitost_procesov]Table 2.1: Efficiency of processes for removing different water contaminants
	Process
	Removal of microorganisms
	Removal of suspended solids
	Removal of dissolved inorganic substances
	Removal of dissolved organic substances

	Biological
	
	
	
	

	  Activated sludge
	+
	+
	-
	+

	  Anaerobic treatment
	-
	+
	-
	+

	  Biofilters	
	-
	-
	-
	+

	Chemical
	
	
	
	

	  Chlorination
	+
	+
	-
	+

	  Ozonation
	+
	+
	-
	ο

	  Coagulation
	+
	+
	-
	+

	Physical
	
	
	
	

	  Adsorption on activated carbon: 
	
	
	
	

		in granules
	-
	+
	-
	+

		in powder
	+
	+
	-
	+

	  Conventional filtration
	-
	+
	-
	-

	  Flocculation + sediment.
	+
	+
	-
	-

	  Membrane processes
	
	
	
	

		MF
	+
	+
	-
	-


Legend: + removal is effective, ο removal is partially effective, - removal is ineffective


If a table or part of a table is taken from another source, it must be cited. If the entire table is summarised, the reference number is added to the table description. If only certain values or text within cells are summarised, this can be quoted in individual cells or at the end of each line.

[bookmark: OLE_LINK4][bookmark: OLE_LINK3]Tables should be legible (it is recommended to use Times New Roman font size of at least 10 pt.), clear, and transparent. Any footnotes or e.g., a legend may be written below the table or figure in a smaller font size (10 pt. or 8 pt.), as shown in Table 2.1. Tables and figures are referred to in normal print and in lower case, as in the previous sentence. All tables and figures should be (pre-)referred to in the text and explained more fully.

[bookmark: _Toc120268082][bookmark: Kumulativne_vrednosti_porabe_vode][bookmark: OLE_LINK27]Table 2.2: Cumulative values of water consumption at all UF units for 2012 [1]
	Month
	Vf
[m3]
	Vsp + Vkč,sp
[m3]
	Vv
[m3]
	Vp,cel
[m3]
	Vpov + Vkč,pov
[m3]
	Vp
[m3]
	εUF
[%]

	January
	34785
	2315
	37100
	34785
	9192
	25593
	69.0

	February
	28575
	1574
	30149
	28575
	8743
	19832
	65.8

	March
	34002
	1517
	35519
	34002
	8963
	25039
	70.5

	April
	32118
	882
	33081
	32118
	7516
	24602
	74.4

	May
	33949
	548
	34497
	33949
	7457
	26492
	76.8

	June
	37004
	137
	37141
	37004
	7175
	29966
	80.7

	July
	34276
	455
	34731
	34276
	7145
	27131
	78.1

	August
	15621
	834
	16455
	15621
	3200
	12421
	75.5

	September
	29969
	595
	30564
	29969
	7937
	22032
	72.1

	October
	31468
	764
	32232
	31468
	8242
	23226
	72.1

	November
	29033
	1143
	30176
	29033
	8065
	20968
	69.5

	December
	31874
	1260
	33134
	31874
	7463
	24411
	73.7




The table should be meaningfully placed in the text. Usually, the table is placed under the paragraph in which the table is first mentioned. If the table is positioned differently for the sake of the flow of the text, it should certainly be positioned close to the first reference in the text.

Where possible, display each table (or figure) on one page. If the size of the table makes it unavoidable to divide it into several pages, at the end of each page (if the table continues the next page) write "continued" at the bottom right and "continued" on the next page (where the table continues) at the top left corner. Be sure to reprint the entire header of the table on each page, numbering the columns as necessary.


[bookmark: _Toc124842334]Figures
Figures should be numbered consecutively. The numbering starts with a number of Level 1 of the chapter in which the figure is located, followed by the sequential number of the figure in that chapter. Figures should be centred. An example is shown in 2.1.

The title of the figure, with the consecutive number of the figure and a brief description, should appear below the figure, centrally aligned with the figure and the text. The title with the figure sequence number of the should be written in Times New Roman, size 11 pt., with the ":" mark after the sequence number of the figure. The image description should begin with a capital letter and end without final punctuation, and should be in Times New Roman upright, size 11 pt. It is recommended to keep the names or descriptions of figures (as well as tables) short, as this is more appropriate from the point of view of the subsequent production of the table of figures (or tables). There should be 2 blank lines between the preceding text and the image unless the image is completely at the top of the page. There should be 1 (blank) line of space between the figure caption and the continuation of the text. There should be no spaces (blank lines) between the figure and the figure caption. The figure caption should be set to 12 pt. top and 12 pt. bottom indent, as shown for figure 2.1. The heading/caption style is already pre-set in this template.


[image: ]
[bookmark: _Toc120268097][bookmark: Primer_slike][bookmark: Delitev_membranskih_tehnologij]Figure 2.1: Image taken with an electron microscope [2]


monomers
polymer
polymerization

[bookmark: _Toc120268098][bookmark: Shematski_prikaz]Figure 2.2: Schematic representation of the polymerization process [2, 3]

Figures must be legible, clear, and transparent. Figures must be of good quality and in the Slovenian language. If a diagram is shown, the magnitudes and units of all axes must be clearly and consistently indicated. The microscopic images must have the length scale marked accordingly. Images should be scanned at the highest resolution possible. Images that you create yourself using programs such as CorelDraw, Photoshop, PowerPoint, etc. should be saved in *.emf (Enhanced Metafile) or *.eps (Encapsulated PostScript) format. This way, when converting the document to *.pdf format, all the details in the image will be preserved and the highest possible quality will be ensured when printing.

Each figure (e.g. including 2.2 and 2.3) should be placed in the text meaningfully. We usually place the figure under the paragraph in which it is first mentioned. If the figure is positioned differently for the sake of the flow of the text, it should certainly be positioned close to the first reference in the text. If two figures are placed one below the other, there should be 2 blank lines between the title of the first figure and the second figure.



[bookmark: _Toc120268099][bookmark: Več_povezanih_diagramov]Figure 2.3: (a) Dependence of the proportion of missed shots in a competition as a function of the training time before the competition. (b) Deformation as a function of the loading time for two different samples.


[image: ]
[bookmark: _Toc120268100][bookmark: Časovno_sosledje]Figure 2.4: Time sequence of a projectile falling into water from a height of (a) 2.1 m; and (b) 4.1 m [4]

As shown in Figures 2.3 and 2.4, you can combine several related diagrams into a single figure, clearly separating them into subsets, i.e. (a) and (b), while taking care of clarity.
If a figure is taken from a specific source, this should be cited, as shown in figure 2.1. All figures by other authors must also be cited.


[bookmark: _Ref412102960][bookmark: _Ref412102955][bookmark: _Toc124842335]Equations
Equations should be aligned 0.5 cm from the left edge of the text. Equation numbers are written in round brackets at the end of the last line in which the equation appears (we recommend using a 2-column table for proper placement of the equation and the equation's consecutive number). The numbering starts with a number of Level 1 chapter in which the equation is located, followed by the consecutive number of the figure in that chapter. The explanation of the equation must be in the text.
	
	(2.1)


	
	[bookmark: _Ref411723838](2.2)

	
	[bookmark: _Ref415042523](2.3)



In the following text, if necessary, reference is made to the corresponding equation number, e.g., equation (2.2).

Letters of the Latin and Greek alphabets, sometimes with the addition of indices and other symbols, are usually used to denote quantities and other symbols. As shown in equations (2.2) and (2.3), the symbols, i.e. the labels of quantities, e.g. e or Pr, must be written in italics. Do not put a full stop after a symbol unless the symbol ends the sentence.

We usually use indices when two quantities have the same symbol, or when we want to further define a quantity (e.g., max as maximum, cel as total, z as initial, etc.). Indices denoting physical quantities are written in italics, while descriptive indices that serve to further define quantities, e.g. "cel" in ecel or "L" in PrL,i should be written in normal (upright) font. Indices consisting of numbers are also written in normal (upright) type (e.g. A1), while indices consisting of letters denoting counts or numbers (e.g. "i" in mi or in PrL,i) are written in italics (italics).

For the correct indication of physical quantities, constants, indices and other elements in the equations, please refer to the "Recommendations for Authors of Study and Professional Publications at the Faculty of Mechanical Engineering in Ljubljana" by senior lecturer Dr. Stropnik [5].


[bookmark: _Toc124842336]Citing and referencing
When citing, please follow the rules of citation, which apply not only to final theses, but also in general to any presentation in which the intellectual or material property of other authors is used. Use as much as possible recent relevant international literature as sources. Online sources may account for no more than 25% of the total sources used in the dissertation.

All references used in the text of the thesis should be cited consecutively in the order of their numbers in square brackets and the bibliography should be numbered according to the order in which the citations appear in the document. Examples are shown in the following sentences:
The work of Bažant and others [1] gives an overview of the effects on the stability of structures.
The work of Bažant et al. [1] gives an overview of the effects on the stability of structures.
In 2005, Bažant and Cedolin [6] introduced the use of modal analysis in structural stability calculations.
The sequence number of the source referred to in square brackets is repeated in the reference list (see 2.6.1 Bibliography list samples), and the same number as the first reference is used when the same reference is referred to again at a later date.

The bibliography used should be left-aligned and formatted according to the examples in this template (see chapters 2.6.1 Bibliography list samples and Bibliography) and should generally include the following information:
the author, title of the work, publisher and place and year of publication if it is a monograph or a book,
the author, chapter title, editor, book title, publisher, place and year of publication and, if it is a chapter in a book or monograph, the number of the opening and closing pages of the chapter,
the author, the title of the article, the name of the journal, the journal number, the year of publication and, if it is a journal paper, the number of the front and back pages of the paper,
the author, title of the paper, editor and title of the proceedings, the place and date of the conference (or publication of the proceedings), and the starting and last page number of the paper if it is a conference paper,
the author (if any), the title of the work, the web address, the time of access if the source is from a website,
the author, title of the work, type of work, place and year of publication if it is a doctoral dissertation or other final thesis.

When referring to a source, multiple authors may use "et al." instead of “and others”, for example: The work of Bažant et al. [1] gives an overview of the effects...

Bibliography list samples are given below. Please include the following and (or) other relevant information for sources such as: conference papers, patents, standards, regulations, prospectuses, studies, other diplomas, or when citing literature:
SIST ISO 690: 1987(E) Documentation – Bibliographic references: Content, form and structure; and
SIST ISO 690 – 2: 1997(E): Electronic documents or parts thereof.


[bookmark: _Ref411790735][bookmark: _Toc124842337]Bibliography list samples
For books:
Z. P. Bažant, L. Cedolin: Stability of Structures: Elastic, Inelastic, Fracture, and Damage Theories. Oxford University Press, New York, 1991.
1. J. Stropnik: Priporočila avtorjem študijskih in strokovnih publikacij na Fakulteti za strojništvo v Ljubljani. Fakulteta za strojništvo, Ljubljana, 1997.

For book chapters:
1. J. Doe: Earthquake stability. In: Z. P. Bažant, L. Cedolin (eds.): Stability of Structures: Elastic, Inelastic, Fracture, and Damage Theories. Oxford University Press, New York, 1991, pp. 124–157.

For journals:
Z. P. Bažant, L. Cedolin: Noise control. Journal of Sound and Vibration 111 (2008) pp. 42–50.
J. Gonzalez-Gutierrez, JL Carillo-Estrada, JC Ruiz-Suarez: Penetration of granular projectiles into a water target. Scientific reports 4:6762 (2014) pp. 1–5.

For conference papers:
1. Z. P. Bažant, L. Cedolin: Modalna analiza. In: B. Podskrajnik (ed.): Kuhljevi dnevi:  Zbornik referatov. Ljubljana, Slovenija, 2005, pp. 2–5.
Z. P. Bažant, L. Cedolin: Modal analysis. In: S. Smith (ed.): Proceedings of the 22. Congress of Polymers. London, UK, 2007, pp. 3–8.

For web resources with a known author:
C. Kogoj: Modalna analiza: izbrana poglavja iz DTD. Available at: http://lab.fs.uni-lj.si/ldtd/Gradivo_za_studente/DTD/Pregled%20teorije.pdf, viewed: 11 January 2012.
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